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Este tutorial está orientado específicamente a la utilización del software DATAMINE para el diseño a realizar en curso MI58B Diseño de minas subterráneas. No es en ningún caso un manual de uso del sistema mencionado. Se reconoce que existen numerosas herramientas contenidas en él que no se mencionan en este documento, siendo responsabilidad del alumno interiorizarse de ellas para su mejor utilización.
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Abrir un proyecto nuevo
Al abrir el programa aparecerá la siguiente pantalla:
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Donde se puede crear un proyecto nuevo o abrir uno ya existente. Si el proyecto ya está creado, en la pestaña “Recent” se puede encontrar una lista de los últimos proyectos abiertos, es relativamente más rápido que buscar el proyecto en el disco duro, opción que se ejecuta al rellenar el marcador “Open existing Project”.

Para abrir un proyecto nuevo debemos rellenar el marcador “New Project wizard” y presionar el botón “Aceptar”. Al hacer esto se nos mostrará la siguiente pantalla:
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Donde debemos especificar el nombre de fantasía del proyecto (“Project Name”; es recomendable asignarle el nombre del grupo) y rellenar ambos marcadores, que facilitan el tratamiento de la información al almacenar todos loas archivos utilizados en un mismo directorio y cargar automáticamente los archivos del proyecto cada vez que se abre, respectivamente. El proyecto está ahora creado, pero obviamente no hay nada en el SÓLO SE PUEDE ABRIR UN PROYECTO A LA VEZ EN EL SISTEMA DATAMINE.
Conceptos básicos
Interfase del sistema

Cada proyecto creado en DATAMINE trabaja con 3 pantallas simultáneamente, que se abren cada vez que abrimos el proyecto, antes de comenzar a trabajar es preciso esperar que se cargen correctamente cada una de las siguientes pantallas:
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Cada pantalla se describe a continuación:
· Visualizer: es una pantalla que permite observar el proyecto en tres dimensiones, rotarlo, hacer zoom, etc. Sin embargo aquí no se pueden realizar ningún tipo de cambios al proyecto, es sólo para observar.

· Design: es una pantalla que muestra el proyecto en dos dimensiones, en cualquier plano especificado por el usuario. Es aquí donde se crea y modifica un proyecto, se añaden galerías, caserones, etc. El sistema de funcionamiento es muy similar a “Paint”, en el hecho que se debe dibujar a mano cada infraestructura que deseemos  añadir, pero obviamente cuenta con herramientas que facilitan esta tarea.

· Output: esta pantalla de texto únicamente es la interfase de comunicación con el usuario.
Archivos del proyecto
Se puede cargar en DATAMINE información de casi cualquier origen (planillas Excel, Autocad, documentos de texto, etc.), sin embargo de es de vital importancia el formato en que ésta esté contenida puesto que el sistema almacena toda la información en archivos de un mismo tipo distinguiéndolos, por ejemplo si se trata de sondajes o de una wireframe, sólo por el formato en que esté guardada la información.

Según lo anterior todos los archivos de Datamine que corresponden a información de un proyecto en particular tienen extensión *.dm y es su formato interno el que diferencia si se trata de sondajes, modelos de bloques, strings, etc.

Archivos *.dmd son proyectos, pequeños en general, guardan información respecto de que archivos están vinculados al proyecto

Para cargar archivos en el proyecto debemos realizar cada vez lo siguiente:
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FILE>ADD TO PROJECT>FILES

Y escoger la opción files, luego de esto se abrirá un buscador que nos permitirá encontrar donde están los archivos que deseemos añadir. El programa detectará automáticamente la información y la almacenará ordenada por sondajes, superficies, modelos de bloques, etc. En caso de no reconocer el formato se almacenará como información genérica.
Que un archivo esté cargado en el proyecto no significa que esté abierto, por lo que es normal no observar nada aún. Para cargar en la pantalla de trabajo un determinado archivo se debe realizar lo siguiente:
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DATA>LOAD>tipo de objeto que se desee abrir.

Al seleccionar alguna de las opciones anteriores (Strings, Points, Drillholes, etc.) se mostrará la siguiente pantalla:
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Que muestra la información ordenada según su tipo de formato (recordar que el formato de un archivo determina de que tipo de información se trata), donde debemos escoger el archivo que deseamos abrir. Los archivos sin un formato reconocible por el sistema están en el directorio “All” y no se pueden abrir para visualizarlos pues el sistema no los reconoce como objetos.

A modo de ejercicio: cargar el archivo contour (Strings) desde la carpeta Database>Tutorial, que corresponde a las líneas de nivel de una topografía ficticia y luego abrirlo para verlo en pantalla (en la pantalla Design). ¿Aún no se ve nada? es porque el programa no ajusta automáticamente el zoom a los objetos que se cargan, pues se pueden tener muchos objetos cargados al mismo tiempo, para solucionar esto presionar en el teclado “ZA” (no es case sensitive) abreviación del comando “zoom all”.
Debería aparecer lo siguiente en la pantalla Design:
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Una imagen plana de las líneas de nivel antes mencionadas. Para ver una imagen tridimensional se debe presionar en el teclado “UV” abreviación de “Update visualizer” (se puede encontrar esta opción con el botón derecho del mouse). 
Si vamos directamente a la pantalla visualizer lo más probable es que no veamos nada, pues este necesita refrescarse cada vez debido a que las imágenes en tres dimensiones consumen bastantes recursos y es improductivo ocuparlos si es que no vamos a visualizarlos, por eso es necesario ejecutar el “Update Visualizer”. Debería aparecer lo siguiente en pantalla:
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Descripción funcional

Menú “Edit”

Como su nombre lo indica en este menú están las herramientas de edición, que pueden observarse mejor en la siguiente imagen:
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Las herramientas más importantes de este menú corresponden a Erase, Select y Snapping, que se describen a continuación:

· Erase: los objetos se pueden borrar por tipos (strings, points, etc). Importante es saber que “erase” un objeto significa borrarlo de la pantalla y no eliminarlo del proyecto hasta que se guarden los cambios.

· Select: Para seleccionar por tipos los diferentes objetos que se encuentren en pantalla.

· Snapping: el snap es una herramienta gráfica que nos permite que el computador detecte automáticamente el objeto más cercano, y al hacer clic en cualquier parte, se seleccione este objeto y no una zona infinitesimalmente cercana. Se pude hacer snap sobre puntos, strings, grillas, etc. Si tenemos activado un determinado snap, este se ejecuta al hacer clic con el botón derecho del mouse únicamente.
Menú “View”

Aquí se encuentran las opciones de visualización: zoom, fijar plano de observación, etc. Más detalladamente en la siguiente imagen:
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Este mismo menú corresponde a la barra vertical situada la derecha de la pantalla Design. Es importante tener facilidad en la utilización de este menú pues nos permite realizar numerosas acciones para facilitar nuestro diseño, veremos en detalle las más relevantes:

· Re Draw: o “RD” sobre el teclado, para volver a dibujar lo que tenemos actualmente en pantalla pues a veces quedan manchas de objetos que hemos eliminado.

· Zoom: para acercar y alejar zonas en el plano y en la visualización 3D que sean relevantes. En la barra vertical derecha corresponden a unas lupas con los símbolos “+” para zoom in y “-“ para zoom out.

· Pan: para mover el plano de observación, su icono es una mano blanca en la barra vertical a la derecha.

· Set clipping limits: el clipping es una propiedad que nos permite proyectar (sólo para su visualización en plano) objetos que estén fuera del plano de observación actual. Se define como una distancia hacia adentro y hacia afuera del plano, todos los objetos contenidos en este intervalo serán mostrados en pantalla. Los límites de clipping corresponden a este intervalo.

· Use clipping limits: opción para habilitar o deshabilitar los clipping límits impuestos.

· Distancia de desplazamiento de planos: su icono en la barra vertical derecha son dos planos con una flecha arqueada de dos puntas entre ellos. Este botón sirve para fijar la distancia en que se moverán los planos.

· Move plane: si icono son unas flechas negras en la barra vertical derecha. Estas sirven para, una vez fijada una distancia de desplazamiento, mover el plano de observación en esta distancia, en dirección ortogonal al plano, en el sentido que indiquen las flechas.
· Plano por 1, 2 y 3 puntos: para fijar un plano se observación por 1, 2 y 3 puntos. Sus iconos corresponden a planos con 1, 2 y 3 puntos respectivamente.

Se recomienda practicar bastante y familiarizarse con las opciones del menú view pues son fundamentales para el diseño que realizaremos.

Menú “Format”
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En este menú se encuentran las herramientas de formato, o sea filtros gráficos, la posibilidad de incorporar leyendas, atributos, etc. Los filtros resultan bastante útiles al momento de realizar un diseño, por lo que se describen a continuación:
· Filtros: se puede filtrar gráficamente cualquier tipo de información cargada en la pantalla Design. Para filtrar debemos conocer previamente que parámetros determinan un objeto específico, o sea, conocer su formato y bajo que campos queda especificado. Para conocer los campos que determinan un objeto puede accederse a la opción Browse Project del menú File y buscar un objeto determinado, aparecerá una pantalla como la siguiente:
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Donde pueden verse los campos que determinan al objeto escogido. Ahora podemos filtrar sin problemas de la siguiente manera:
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Mostraremos entonces solo las strings que en su campo COLOUR tengan el valor 1, al presionar OK aparecerá nuevamente la opción de un filtro, podemos añadir otro o simplemente volver a presionar OK con el cuadro de texto en blanco para aplicar el filtro especificado en el primer paso. Luego hacemos Re Draw (“RD” sobre el teclado) para ver los cambios realizados.
Como se dijo anteriormente se puede filtrar sobre cualquier campo de cualquier objeto, pero previamente se debe conocer los nombres de cada campo, los que si son Case Sensitive al momento de filtrar, por lo que se deben tomar las precauciones pertinentes.

Menú “Design”

Este menú contiene las herramientas necesarias para crear y editar nuestro diseño, puede verse a continuación:
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Existen aquí numerosas herramientas cuyas funciones conviene comprender profundamente para facilitarnos el trabajo de diseño. Básicamente se trata de dibujar a mano nuestro diseño, pero obviamente hay facilidades para la creación de galerías, túneles, caserones, etc. El manejo adecuado de strings (o simplemente líneas) es fundamental para poder realizar nuestro diseño. Las más útiles se encuentran en el submenú string tools, destacándose entre éstas:
· Insert points: añade nuevos puntos en una string, muy útil.

· Delete points: borra puntos en una string, muy útil.

· Break: diferentes posibilidades para cortar un string.

· Connect: para juntar dos strings distintos.

· Reverse: los puntos que conforman un string están ordenados, o sea existe un primero, segundo, etc. Que al momento de conectarlos tiene importancia, por ejemplo: al conectar dos strings, se conectan el último y el primer punto del string 1 y 2 respectivamente.

· Clip to perimeter: permite ajustar un string a un área confinada, borrando cualquier segmento que se salga del perímetro de ésta.

Strings

Un string es básicamente una línea, que queda definida por los siguientes campos:

· PVALUE: número identificador del string.

· PTN: número de puntos del string (hasta un máximo de 1000).
· XP,YP, ZP: coordenadas cartesianas de cada punto del string.

· COLOUR: o cualquier atributo (atributo sirve para filtrar información).
Menú “Wireframes”

Un objeto tan útil como las strings son las wireframes, conviene también tener un adecuado manejo de las herramientas presentes en este menú, pues pueden ahorrarnos bastante trabajo:
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Las más relevantes se describen a continuación:
· Move: operación básica para mover una wireframe.
· Copy: operación básica para copiar una wireframe.

· Interactive DTM creation: submenú para facilitar la creación de wireframes (muy útil).

· Boolean operations: nos permiten combinar (merge), unir, intersectar, restar, rebanar, etc. Una determinada wireframe. Estas herramientas funcionan como diagramas de Venn (conjuntos, Álgebra, primer año) sobre una o más wireframes, según corresponda. Estas son particularmente importantes pues nos permiten intersectar por ejemplo un caserón con un cuerpo mineralizado y cuantificar tonelajes.
Wireframes

Una wireframe puede definirse como una superficie y existen dos tiempos de wireframe para DATAINE:

· DTM o wireframe abierta.
· Wireframe cerrada.
Para ambos casos, la creación de una wireframe involucra la creación de 2 archivos diferentes, que se describen a continuación:

· Archivo de puntos: por ejemplo, si nuestra wireframe se llama wf1.dm, el archivo de puntos de la wireframe debe nombrarse como wf1pt.dm. En este archivo quedarán almacenadas las posiciones de cada punto de la superficie.

· Archivo de triángulos: que en el ejemplo debe llamarse wf1tr.dm. En este archivo quedarán almacenadas las líneas que conectan cada punto de la wireframe.

Si se guarda un solo archivo (el de puntos o el de triángulos) el sistema no reconocerá a wf1.dm como una wireframe, por lo que no se podrá editar desde el menú wireframe, volviéndolo inútil.

Por otro lado, no es necesario que creemos manualmente estos archivos, si creamos una wireframe desde el menú y escogemos la opción Save Wireframe del menú Data, el sistema pedirá un nombre para el archivo y automáticamente añadirá las extensiones *pt.dm y *tr.dm. 

Es importante saber además que las wireframes se seleccionan según la característica que especifiquemos, esto es, según sus atributos (colores, por ejemplo), por grupos, etc. Para elegir el tipo de selección debemos ir al submenú Wireframe settings, en el menú wireframe, donde veremos lo siguiente:
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En la pestaña wireframing, en el recuadro selection están las mensionadas opciones de selección. Es bueno revisar siempre que tipo de selección tenemos active, pues a veces ocurren problemas al tartar de escoger una wireframe determinada que se solucionan con esto.

A modo de ejemplo: añadir al proyecto los archivos orept.dm y oretr.dm (que corresponden a un cuerpo mineralizado) de la carpeta Database>Tutorial. Cargarlo en pantalla (recordar la herramienta “zoom all”), crear una copia de este cuerpo y situarla en una posición tal que haya intersección entre ambas, luego hacer que la intersección de ambas sea un sólido (o wireframe cerrada) independiente.

Luego de cargar en pantalla el cuerpo mineralizado (ya debiesen tener facilidad para esto) pude crearse fácilmente una copia de esta wireframe con la herramienta “Copy wireframe” del menú Wireframe (el sistema va indicando los pasos para realizar la copia, es sencillo). Podemos situar la copia inmediatamente en un lugar en que haya intersección entre ambas estructuras. Luego con la herramienta “merge” del submenú Boolean operations, del menú wireframe, combinamos ambos sólidos, al hacer “Update visualizer” veremos:
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El volumen en azul es ahora un nuevo volumen, corresponde a la zona de intersección entre los volúmenes originales (operación MERGE).

Se recomienda practicar y comprender al menos las funciones Merge, Intersection y Diference de este menú, pues facilitan mucho el trabajo de cubicación.

Menú “Tools”
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Las herramientas más importantes del menú Tools son las macros y los archivos CL que básicamente corresponden a:

· Macros: al grabar una macro, grabaremos todas las acciones que realicemos (seleccionar un menú, cargar un archivo, crear un atributo específico, etc.). esta herramienta sirve para realizar labores que debemos repetir constantemente. Si la macro está bien grabada, podemos ejecutarla cada vez, en vez de repetir manualmente las operaciones requeridas. Cuando una macro está grabando, graba TODO lo que hagamos, es decir, lo bueno y lo malo, por lo que hay que ser precavido si se escoge esta opción, de todas maneras, siempre se pueden editar en forma manual, pero para esto se debe conocer el código de programación.

· Archivos CL: corresponden a macros pero con posibilidades mas restringidas, se usan principalmente para grabar leyendas de colores. Para esto debemos crear un archivo CL que genere esta leyenda y ejecutarlo cada vez que queramos verla. Parece complicado pero facilita mucho las labores cuando necesitamos muchas leyendas distintas. Al igual que las macros se pueden modificar posteriormente pero se debe conocer el lenguaje de programación.
Cuidado al sobrescribir un archivo CL o una macro pues estos no se sobrescriben realmente, cualquier cosa adicional que hagamos, se añade a continuación de la última línea del archivo, es conveniente borrar del disco duro el archivo respectivo antes de ocupar el mismo nombre para guardar una macro.

A modo de ejemplo: vamos a crear una leyenda de colores que diferencie por litologías una campaña de sondajes.
Para lo anterior debemos crear la información referente a los sondajes, para poder visualizarlos, ya que la información es entregada por separado. Para esto debemos ejecutar el proceso HOLES3D (en el recuadro blanco en la esquina superior izquierda de la pantalla):
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Toda la información necesaria para el input está en la carpeta Database>tutorial. El nombre del archivo de output es determinado por el usuario, aquí se guardara la información en formato de Drillholes (sondajes), de manera que el sistema lo reconocerá y podremos verlo en pantalla. Luego de la ejecución del proceso HOLES 3D podemos cargar los sondajes en pantalla.
Para generar una leyenda debemos ir a donde muestra la siguiente pantalla:
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Al seguir el wizard que se abre al escoger esta opción podremos asignar colores a cualquier variable que queramos, pero debemos conocer previamente los campos que definen al archivo de sondajes generado (ver en File>Browse Project).
Si antes de realizar todo lo anterior (luego de la ejecución del proceso HOLES3D) escogemos la opción Record CL file del menú tools y al finalizar escogemos Stop CL recording del mismo menú, nuestra leyenda podrá ser cargada cada vez que queramos al escoger la opción Run CL file.

Creación de un modelo de bloques
Es necesario realizar modelo de bloques tanto en el estéril como en el mineral. Necesito cuantificar e identificar de manera exacta el estéril relacionado al yacimiento para, por ejemplo, control de la relación estéril mineral. Sin embargo sólo hago cálculo de recursos y reservas con los bloques mineralizados. Para generar un modelo de bloques se debe realizar lo siguiente:

· Cargar en pantalla las wireframes de topografía y cuerpo mineralizado (_topotr y _topopt ( wireframe topografía, _oretr y _orept ( wireframe mineral). Todos los archivos están en la carpeta Database>tutorial.
· Generar modelos de bloques para estéril (topografía) y para mineral (mineral).

· PROTOM: genera prototipo de modelo de bloques nuevo (puede alcanzarse desde Models > Create models >Define prototype).

· Para prototipo necesito tamaño de celda, coordenadas de origen y número de bloques (es bueno conocer estos parámetros antes de ejecutar el proceso PROTOM).

· Tamaño de celda (XINC=10; YINC=10; ZINC=10, son los campos en el modelo de bloques que identifican los parámetros respectivos).

· Coordenadas de origen (Xo=7600; Yo=6200; Zo=200) vértice inferior izquierdo (origen cartesiano). Atributos se refieren al centroide de cada bloque.

· Cantidad de celdas (NX=80; NY=80; NZ=30).

· El prototipo es un tipo de archivo similar a un modelo de bloques, pero no tiene más registros que los introducidos acerca del tamaño, coordenadas de origen y número de celdas.

· Is a mined out field required? No. Si necesito representatividad de sectores extraídos (genera un campo llamado FILLVOL ( volumen efectivamente relleno con material).

· Are subcells to be used? No. Se refiere a discretizaciones menores del bloque.

· El resto del proceso PROTOM se rellena con los parámetros que definimos anteriormente (fijarse en el orden que deben ingresarse en la pantalla output).

· Proceso PROTOM está ahora completo.

· TRIFILL: (Models>Create models>Fill wireframes with cells) rellena con bloques un sólido de acuerdo al prototipo. Pestaña Files: PROTO: ingresar archivo prototipo anteriormente creado. WIRETR y WIREPT wireframe para generar modelo de bloques (topo para estéril, ore para mineral). Pestaña Fields: crear campo para diferenciar estéril de mineral (ZONE “ROCA”), se pueden crear diferentes campos para otras necesidades. Pestaña Parameters: MODLTYPE: cada valor corresponde a una forma distinta de rellenar el sólido (revisar help de abajo en el mismo recuadro) se debe colocar “3”. ZONE: valor que tendrá el campo definido el Fields (coloco “0” por ser estéril). SPLIT (“0” para no colocar subceldas, número de particiones en el plano de llenado) Y RESOL (regula tamaño de particiones en el eje ortogonal al plano de llenado, se define como el inverso del valor entregado a este parámetro “1” para no usar subceldas): controlan parámetros de las subceldas (X, Y, Z SUBCELL son sólo refernciales). PLANE: plano de llenado, secuencia de llenado del bloque. Pestaña Retreival: para aplicar filtros, no lo usamos.

· Proceso TRIFIL finalizado. Lo mismo para mineral.

· Hay que unir ambos modelos de bloques en uno solo puesto que DATAMINE sólo puede trabajar con sólo un modelo de bloques en pantalla a la vez.

· ADDMOD: (Models>Manipulate models>Add two blocks models) para unir modelos de bloques (el que se ingresa segundo reemplaza al primero en las zonas donde se superponen).

· GRADE: (Models>Interpolate grades>basic grade interpolation) para asignar valores de leyes al modelo de bloques creado recientemente. Requiero información de leyes proveniente de sondajes. PROTO: se carga el modelo de bloques que contiene sólo al mineral (también se puede estéril pero no es necesario). Pestaña Fields: X, Y, Z son coordenadas de los sondajes. VALUE: valor que se va a estimar en los bloques con la información de los sondajes. Pestaña Parameters: SDIST 1, 2, 3: tamaño del elipsoide de búsqueda. SANGLE y SAXIS son para rotar el elipsoide. MINNUM y MAXNUM: mínimo y máximo número de muestras para estimar una celda. IMETHOD: proceso para realizar estimación (Kriging, inverso de la distancia, etc.). MINOCT: mínimo de octantes requeridos para que se estime la celda. MINPEROC, MAXPEROC: mínimo y máximo de puntos por octantes requeridos. X, Y, Z POINTS: discretización del bloque. “clf” para borrar modelo de bloques de la pantalla, “clw” borra todo lo que hay en la ventana.

· El modelo de bloques está finalizado completamente.

Diseño subterráneo
El diseño subterráneo de basa principalmente en la utilización de strings y wireframes y básicamente se debe dibujar “a mano” las diferentes estructuras que queramos, pero obviamente existen herramientas que facilitan estas labores. Estas herramientas están en el menú Applications>Underground.
Caserones

Un caserón es en DATAMINE un volumen cerrado, o sea tiene características de wireframe. Dado que un caserón es geométricamente más “cuadrado” que un cuerpo mineralizado.
Para armar un caserón se debe primeramente crear los strings que corresponden a las tapas de éste. En el menú Design>Rectangles hay opciones para crear rectángulos de manera más fácil, debemos crear al menos dos caras paralelas del caserón. La herramienta Design>Translate String permite desplazar y copiar una cara del caserón (si es que necesitamos simetría. Lo anterior se verá así (en la pantalla visualizar):
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Posteriormente se deben conectar los vértices de estos dos strings con un string conector especial que se encuentra en el menú Wireframes>Linking>Link Strings, se deben conectar ambos lados del caserón, se obtiene algo como lo siguiente, en la pantalla visualizer:
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Nos falta ahora tapar los lados del caserón. En el menú Wireframe>Linking>End Link encontramos la aplicación necesaria. Debemos seleccionar los strings que delimitaban inicialmente los lados del caserón, se obtiene lo siguiente en la pantalla visualizer:
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La herramienta Models>Evaluate>Evaluate wireframe sirve para calcular el volumen de una estructura determinada. Sus resultados aparecen en la pantalla output.
Túneles y galerías

Los túneles y galerías se generan por la extrución (en inglés, to extrude) de una sección determinada a lo largo de un string guía. Un string guía es una string común y corriente por que servirá de carril para el desplazamiento de una sección transversal específica.
Diseñar y asignar una sección

Para diseñar una sección determinada se debe acceder a la opción Select cross section, que se encuentra en el menú Applications>Underground>Drive linking>Select cross section.

El parámetro NUMBER es un código identificador de la sección, los otros parámetros son de diseño. El parámetro String ht es la posición por donde pasa el string guía pues no necesariamente es el centro de la sección.

Luego de tener el string guía creado y la sección que deseamos hay que referenciar ambas. Para hacer esto debemos recurrir a Applications>Underground>Drive linking>Assign cross section. Al hacer esto se extruirá por el string guía la sección determinada, generando una galería.

Rampas

La creación de una rampa es similar a la de una galería, se debe tener un string guía y una sección transversal determinada. La diferencia es que el string guía está inclinado y para facilitarnos esto (la creación de un string guía con una cierta pendiente) podemos recurrir a Applications>Underground>Tools>Create ramp string. Luego se debe proceder de igual forma que en túneles y galerías.

La herramienta Applications>Underground>Connect on Gradient permite conectar dos labores determinadas con la pendiente especificada.

Cubicación gráfica
La herramienta Models>Evaluate nos permite cubicar dentro de strings, sólidos, etc. Los reportes entregados dependen de la leyenda existente (si ésta fue hecha con assign fill codes). Los resultados aparecen en la pantalla output. Más detalladamente a continuación:

· Inside strings: evalúa dentro de un string cerrado, dándole un margen para generar un volumen a evaluar.

· Inside between two strings: evalúa el sólido generado entre dos strings de distinta cota.

· Wireframe: evalúa el volumen contenido dentro de una wireframe.

· Models>Edit cell values. Sirve para visualizar las características de un bloque además de modificarlas.
Curvas tonelaje ley

Si se desea generar la información necesaria para trazar una curva tonelaje ley esto se hace de forma indirecta, esto es, dado que la herramienta Models>Evaluate reporta información de acuerdo a la leyenda existente, podemos generar una leyenda con los intervalos de leyes que nos interesen para generar la curva tonelaje ley y de esta manera, al utilizar esta herramienta, recuperar la información necesaria para generar dicha curva.
Cubicación con procesos
El proceso EXTRA (que se ejecuta en el recuadro superior izquierdo de la pantalla) que también se puede alcanzar desde Edit>Transform>General, nos permite asignar densidades (o cualquier otro parámetro) a un modelo en particular.
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El campo DENSITY debe tener este nombre para que el software lo reconozca como un valor de densidad. Se especifica a continuación con mayor detalle:

· La pantalla Expresión Translator funciona en forma similar a la programación en JAVA, ero con sus propios comandos (ver menú Help). Antes de poder EXTRA debe probarse el proceso con el botón TEST.

· En el modelo de bloques asignado a la salida del proceso EXTRA se agregan las nuevas columnas DENSITY, VOL y TON con los valores que asignemos en la pantalla anterior.

· MGSORT: permite ordenar archivos asigando filtros y condiciones diversas.

· STATS: genera estadísticas de un archivo determinado. Para hacer un reporte según un campo determinado, el archivo debe estar ordenado según este campo. Si no se desea esto también pueden aplicarse filtros.

· Los archivos se pueden exportar a Excel. Data>Export. Aquí se debe tener claro que tipo de información vamos a exportar (para Excel son tablas, pero pueden ser strings, wireframes, etc.). las tablas se exportan como ODBC. Deben exportarse los datos a un archivo Excel existente, el software no es capaz de crear por si solo este archivo.
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